IHypenview: Browser

Iirace signals, search, troubleshoot, view live data,
examine configuration errors, and much more.
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About DBDOC and Hyperview

» DBDOC compiles all your INFI 90 resources into
a single snapshot file representing your system.

» You can browse the snapshot using Hyperview,
the DBDOC browser.
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2.1.1 How to run Hyperview

From inside BuildPlus

» Open a project and click View project File button
From a shortcut

> Most users have a shortcut to a shared Hyperview in a
central location.

» From the Start menu, select Programs | GMCL
DBDOC | Run Hyperview or Programs | GMCL
DBDOC Hyperview | Run Hyperview

Multiple Hyperview browser windows

» From inside Hyperview, start more browser windows
with File | New Window.



2.1.1.1 Running Hyperview from the

command line (advanced)

Hyperview can be launched from the command line. This
allows fine-grained control of Hyperview options, and is
necessary in order to define a shortcut.

From the command line you can

»Specify the project file to be opened
»Specify the initial document to be displayed
»Disable continuous live data collection (See section 2.5)

»Specify the default live data update interval

See the documentation for more details.



2.1.2 How to load a project file

» Use the File menu to open a project file

> Use File | Recent Project Files to see recently viewed
files

» Use * on the command line (in a shortcut) to
automatically open the most recently built project file.

> Associate project files with Hyperview so they get
opened automatically



2.1.2.1 Associating project files
with Hyperview in Windows

To make Hyperview open when you double-click on an
project file, do the following:

1. Go to the Start menu, click on Control Panel, locate the Folder
Options icon and double-click on it.

2. Inthe Folder Options, click on the File Types tab.

3. Click the New button below the Registered File Types. In the File
Extension box enter project as the File Type.

4. Once it is added click the Change button below the File Types
box.

5. Select the program to open the file from a list selection.

6. Browse to C:\Program Files\GMCL\DBDOC\Programs and
select hyperview.exe as the program to open the file.



2.1.3 Help and documentation

>

Use the Help menu to automatically bring up
application help

Go to the GMCL website (gmcl.com) to access
online help

Help | Project File Build Revision tells which
version of Hyperlink built the current project

Help | About shows the the Hyperview version



2.2 Basic navigation In Hyperview

The browser display has two panes.

Index Pane Content Pane
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2.2.1 Pane orientations

H s

» Push button to control
the pane layout.

> Adjust the dividing bar
between panes.

7777777777777777777

» Pane preferences are
saved for next time.




2.2.2 The index pane (left, top)

> On startup the main table of contents is I LLE

release build

in the index pane_ Table of Contents

Databases

» Click on (links) in the index
pane to display documents in the other
pane.

> Buttons for quick index navigation:

b VW
s 4

—

Step through topics Step through links



2.2.3 The content pane (right, bottom)
Displays graphics, CAD/CLDs, other documents.

YL |AraPictur | Alafs SERV N

0verview

> Highlight | Hotspots  [etinmgil ../« Conpressi
(WGB1-FLM-10250) WASTE
makes |inkS ViSible C;ASBRNR]FLAMEON E} %

» Pointing finger cursor & o
over hotspots

GAS COMP OVEH

» Click on a hotspot to
see all the uses of a
value in the index
pane.
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2.2.4 Focus for the active window

Focus is shown by the colored border
around the index or content pane.
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2.2.5 Setting a “Home Page”

Use right-click Make This Topic My
<Content/Index> Pane Home Page
on any document.

Bookmark This Topic...

‘ E‘H

Mark This Topic For Printing

q Make This Topic My Content Pane Home Page

Document

13



2.2.6 Scrolling

» Use the mouse scroll wheel to
scroll up and down on text
documents in both panes.

» Citrl+scroll to scroll on graphical
documents in the content pane.

Lai

&
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2.2.7 Zooming

>

>

Use the scroll wheel to zoom
In and out

Hold Ctrl and drag the —

mouse to make a rectangle
to zoom in on.

Use the toolbar buttons or;

keyboard. \

Manually set the
magnification factor

15



2.2.8 Using browser history

Hyperview history support is similar to that of
other browsers like Internet Explorer.

The black arrow shows you everything in
the history.

16



2.2.9 Using bookmarks for quick
access to pages of interest

> Add bookmarks to any document.
» Share your bookmarks with other Hyperview users.

» Manage your bookmarks.

B | Manage Bookmarks

Indude shared bookmarks from

'-,-'g|_|; Cherilyn on LEGOLAS % INDEY: Module 1,20,02 Block 1574

v| Rob Brown (Person on WALLACE-T. {::

17



2.3 Techniques for signal tracing

Two methods for signal tracing

1. Click on a hotspot in the content
pane to see its uses Iin the index
pane.

2. Double click on a hotspot in the
content pane to jump directly to
Its source or one of its uses.

18



2.3.1 Trace signals using hotspots
and the index pane

Click on hotspots in the index pane to
display the document in the content pane.

Block Use Index
Module 1,20,02 Block.2%44

3 iR 239D
(NOT: Mot [FC33])




2.3.2 Trace signals using Go To Use,
Go To Source, and double-click

OAD 1D RAMNON

‘ MVAR‘

BREAKER

Right-click or
double-click on
hotspots to trace =
the index pane. e csronn smar muuss

NCE

Go to Block Map

DISTILLATE FUEL
L FIRE MODE
M™ MW LOCK SETPOINT

N STEAM TRIM
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2.3.2.1 Quick ways to jump to the
source of a value without

using the index pane.

» Double-click on
a value to jump
right to its
source.

> Right-click on a
value. Select Go
to Source

CHEMICAL
WASTE SUMP

C
§

TURBINE BULDING | <—

OILY WASTE SUMP |
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2.3.2.2 How to jump to uses of a value
without using the index pane

» Double-click on a non-source value to show
a list of uses. Choose one.

> Right-click on a value. Select Go To Use
and choose a use to go t.

Help about XOR: Exclusive OR [FC

Func mentation (P

Search for

Copy "6712"

Create Text Annotation for this Block
Create Live Loop Annotation for this Block
Add this Block to the Watch Window

Standard Inputs an

15 (KLB/HR)
0.0

+ n
— . =

Show Live Specs for this Block

500.0
500.0 G dule1,01

Retrace G se

]

Go to Block Map

Source (; L [FC101])
Input 54 to block 4311 (DEL PID: PID Control (PY and 5P)
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2.3.3 How to display the input or output
signal tree for a block

Hyperview makes it easy to see all the
signals that may affect a block, and all the
signals that are affected by it.




2.3.3.1 Displaying the input tree

* Right-click on a function block and
choose Show Input Tree For This Block

* All of the input signals for the block, and
their inputs, are highlighted

Tree Root

: @l Tree continues on
_________ HTPIC161 CLOSE :_:rf,n‘q}ll.l'éla O‘ther CAD/CLD

[Fead]

CLOS iCy
___________________________



2.3.3.2 Displaying the output tree

* Right-click on a function block and
choose Show Output Tree For This Block

* All of the output signals for the block, and
their outputs, are highlighted

(CNTY 40r1170

Tree Root

BN Tree continues on
SRS other CAD/CLD



2.4 Searching text, topic titles,
databases, and finding
coordinates

Hyperview makes it easy to search.

; B
-

= Database search

Full text search

> Search all titles

The icon will show your most recent search type.



2.4.1.1 Text searches

Search

Full Test Search | Database Search | Search All Titles |

Search phrase

» Searches all text, on graphics, Wit 7 oy e chascis)

CAD/CLD, AutoCAD drawings.

» Search for a specific word or,
phrase.

» Search for word combinations
with AND and OR.

> U Se Wi Id Ca rd S * . I+ Show Loop, PCU, Module, Block columns

[+ Show Mumber of Hits per Topic

. . c v Show Group
> LI m It Sea rCh eS to pa rtl Cu | < f-"laxirEum Mumber of Search Results (0 for no mit): [0
Kinds of documents.
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2.4.1.2 Database searches

Search

Full Text Search Database Search | Search All Titles |

S e a rC h e S th e d ata b a S e S fo r Entertext in any bax or boxes to find tags in the database.

Find tags with matching tag names

b | OCkS a n d tag S . Example: ‘ail"in this box will find all tags with ‘ail’in the tag name.

Jw to match: Any part of text

> Sea rCh by tag n a m e O r pa rti al Find't;igl:z:? Ilw Trend Index: li

tag n a m e Find tags by Loop, PCU, Module or Black
Loop: I— PCU: l— Module: l— Block: I—

»Search by tag or trend index P togs by

Bxample: tank’in this box will find all tags with tank’ in the tag
description or other database texd.

»Search by any combination of oclres e ]
Loop, PCU, Module, Block e

» Search by description text




2.4.1.3 Search result options

You can specify what information is
displayed with your search results.

» Show search hit frequency
» Show topic groups hits are found in

» Show Loop, PCU, Module, Block of results



2.4.1.4 After your text or database
search you can...

> Display search result
topics in the browser
window (double-click

Batch Programs,
Batch Programs, Module 1,01
Module 1

> Export the results to
a .tsv file

» Search again!




2.4.1.5 Displaying and stepping
through search results

You can step through search results without the
search results dialog using toolbar buttons.

> I Next search hit in topic

> Bl Previous search hit in topic

> Next topic in search results

%

> Previous topic in search results



2.4.2 Using the fast topic search

> Search All Titles shows results
interactively.

> DBDOC narrows the search based on
what you type.

Search

Full Text Search | Database Search Search All Titles |

Documenrt title:

PALM (Module 1,01,02 Block 5056)
PALM {Module 1,01,02 Block S66)
PART.DY [Symbals]

32



2.4.3 Finding a coordinate

» Go directly to a specific coordinate on a
document

» Particularly useful when analyzing error
reports

Coordinate Locator Dialog

Enter the coordinate set to locate:




2.5 Guide to live data on
documents

It's easy to display live data on documents. Use
these toolbar buttons:

> Turn on live data in Snapshot mode

> Turn on live data in Continuous mode

= Add a Live Loop Annotation for a specific
block



2.5.1.1 Live data in Snhapshot mode

Press to turn on live data in Snapshot mode.

In this mode, live data is refreshed every 10s or when
you:

» change documents
» move around or zoom in a document
> click on the camera button again

Snapshot mode is the most efficient way to collect live
data

Values will turn gray when they are considered “stale”



2.5.1.2 Getting live data In
Continuous mode

Press to turn on live data in Continuous mode.
» Continuous mode updates live data at a set interval

» The update interval can be changed in the Options
| View dialog

» Continuous mode is automatically turned off when
you change documents



2.5.1.3 Managing live data load

» Double-click on the camera to turn off
Snapshot mode

» Only visible values are fetched — to fetch
fewer values, zoom in to an area of interest

» Monitor the data load in the status bar

@[5end/s:3.00 Recv/s:3.39] Data Files [204KB] #&

37



2.5.2 Live loop annotations

“Sticky notes” that display live
data. Use them to:

> View live data for a single
block

> View the status of any module
In the system

> Monitor data from another
document

Ta . beginning with V

Example: track a tag's value Lo eymenmen s
while viewing its database
entry

38



2.5.3 Creating a live loop
annotation g2

> Right-click on a hotspot, choose
Create Live Loop Annotation for
this Block, then choose the type
of annotation to make.

> Or, to specify an arbitrary block,
press the =& button, or right-click
anywhere and choose Live Loop
Annotation | Create.

39



2.5.3.1 Specify the block or tag

You can specify the block to monitor.
Block Number,..

{* Value For Block Number

Lr.'-r.'-n:il_ Pf:u:[!_ qu:[l_ Block: 5-‘159
Tag Name...
You can

quickly find

... then enter the

loop, PCU,
module, and block
numbears hara.

..lype in all or part of
the tag name you want
and click Search...

When select the

Swlalue For Tag Name ag you wan
tag names to — rom tis st
It TagName [ Loop [ P [ Mode | Biock | Descryo-

monl Or SDDMO0 1 E 2 2341 )

SDOMSaGW -1 1 | 2 2115

SDDMC 1004 1 1 3 5455
[T L, s e ] u "5 ECLC™
]

40



2.5.3.2 Live loop annotation options

Choose the type of
annotation to create

Plot or Dynamic Bar

Range
’7

{* Auto Range (calculated on the fiy)

li
" Specify Ranae ':' | 1

41



2.5.3.3 Symbols on live
loop annotations

[=1C=]

The green check 7y~ 1,01,02 B 6824

means all is well. 2321875 H

Other symbols can indicate a problem. E
Check the help for more information if . ==

you see them.

Problems with the network connection are indicated
In the status bar.

Send/s:3.00 Recw/s:3.39] Data Files [294KE] 5}

42



2.5.4 Managing live loo
annotations %

Manage Annotations

You can see all the

Specify Value to Maonitor:
Live Loop Annotations (LLA): Pz SR

sl lel Al Aols T —— Cmme
project at a glance .
In the Annotation

Manager.

5 updat:
91

Any annotation can
be edited or
deleted here.

h Impart

e Annotations
Annotations Smotioys From File

43



2.6 Trending live data In the
Watch Window

> Plot data from any
block in the
system

> Plot groups of
blocks together

> Plot data from
non-tagged blocks

» Control data fetch
rate for each block

44



2.6 Trending live data In the
Watch Window

> Display data at
different resolutions

> Mark points of
interest with
timestamps

> Print plots

> Export plot data to aman S
other applications



2.6.1 Opening the Watch Window

To open the Watch Window:

demo daily release build_201909123 r2015-09-10-86149.dbdo

File Group Block View Options Help

> Press the
button on the f
toolbar RN T Nl

1.20.02 B 564

[5-24-2015 [9-24-2019 | S 2a0iE
o |16:45:26.6716:46:01.284 16:47:00

L DEHYDR

> Press W

> Select View |
Watch Window

46



2.6.2 Adding blocks to the
Watch Window

In the browser window:

» Right-click on a hotspot and choose Add This Block
to the Watch Window

» Right-click on a Live Loop Annotation and select
Add to Watch Window

In the Watch Window:
» Use the Add Block button

»> Double-click on a blank area of the block list on the
right side of the Watch Window.

47



2.6.3 Defining and editing plots in the
Watch Window

Watch Window Options

Display

| Reverse Y-axis

»You can flip the plot vertically -

»Choose the plot color pEROING Auscpme [—

after 24 hours

»Pause data collection

> Specify the Y-Axis range

. . This is the minimum value that This is the maximum value
» Or use the built-in range wil b dispiyed on e et wil b dspiayed on the
vertical axis of the watch vertical axis of the watch

window or dynamic bar graph. window or dynamic bar graph.

> Or have it done automatically ‘e

* Auto Range (calculated on the fly)

To edit a block, press

or double click on the block in the block list.

48



2.6.4 Creating groups of blocks
in the Watch Window

> Create multiple groups to organize your blocks in
the Watch Window.

» Name each group whatever you want.

> Blocks in a group are plotted together.

» To add a group press the Add Group button.
(] Gr-n-up-a [F] Group 4

5-24-2015 9-24-201% 9-24-2015 5-24-201%
16:32:00 16:33:00 16:34:00 16:35:00

| MAJIDDT 1.20,02 B 7295 FILTER F701 GLYCOL DEHYDR.
A

49



2.6.4.1 Importing a list of blocks from
CIULInk to the Watch
Window

> If you use ClIULink to monitor groups of blocks,
you can import the group into the Watch Window

» Use Import | Group or Import Group button

Import CIUUNK Group

Enter a name for this group: | Group 2|

Import Groups

CIULink List file: |

ar

n

10



2.6.4.2 Managing groups of blocks
Manage groups:
» With the Group menu in the Watch Window

> With the Watch Window toolbar

» By right-clicking a group tab

5-24-2015 9-24-201% 9-24-2015 5-24-201%
16:32:00 16:33:00 16:34:00 16:35:00

MAJIOOT 1,20 02 8B 7299 FILTER F701 GLYCOL DEHYDRE.
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2.6.4.3 Add all block inputs and
outputs to Watch Window at once

» Right-click on a function block on a CAD.

» Choose Add Standard Inputs and Outputs to Watch
Window.

» Handy for adding groups of blocks to monitor together.

MSCIC128 MA MPCG/P: Contrel Station

8-12-2015 8-12-2015
13:20:00 13:22:00
s variable for MSCIC138

N N
; TMCES
2400 L3d7.44%
AT

J1.01.038 4271 MSCIC138: P DRUM LEVEL CONTROLLER

—r
-------------

B0~ TERAR BR

8000 - [



2.6.5 Watch Window highlights

[190 deme daily release build_20190912a r2019-09-10-86149.dbdoc] Live Data Watch Window

File Group Block View Options Help

Pririt Fdd
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9-24-2019
16:47:00
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2.6.5.1 Watch Window highlights:

Timestamps & Freeze Scroll

Click on the plot to make
a permanent “timestamp”
marking a plot location.

As you mouse over the
plot, a crosshair shows
data and time values.

Navigation Plot ﬂ- e
shows a birds-eye | 5 | SR
collected.
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2.6.5.2 Watch Window highlights:
Split Plot & Time Scale

Multiple plots in a group can be displayed overlapped
or separately.




2.6.5.3 Watch Window highlights:
Go To Source, Go To Block Map

You can jump directly to a block source or block map
from the Watch Window.

&=== Ight-click on a
atch Window

aall/ block and choose
r% Go To Source.

| = o 1 he block source
TR T in the

- configuration is
displayed.

Per Pixel

56



2.6.6 Navigating plot data

There are two shortcut ways to navigate
your Watch Window data.

3212018 U

» Create timestamps and ~ fogurBEE arot:29 [
step through them (or | |
jump direCtIy to any Navigation Kl i =] el Mavigation LI INAY)

timestamp)

» Step through data runs

Cata Run Mark
r-l::ilga:i?:-n - Mﬂﬂﬂ

57



2.6.6.1 Navigating with timestamps

Click on the plot to create timestamps.

E [i190 demo daily release build_20191008b_r2019-10-04-36258.dbdoc] Live Data Watch Window

File Group Block View Optiens Help

O RO

_ Print Add T Delete
“isible Data roup Group

10-1-2019 10-1-2019
16:44:00 16:46:00

217.256

+

o [ T T | IE,m,Z;:r:: K&l 2l =l el B
E T

Timestamp 4 o |l Data Run Marker Plot = o0 Seconds Anoly E Line Ir'.'art
Navigation ﬂj M| ”J Mavigsticn Mﬂﬂﬂ Resol . .L—I Per Pixel Q PRly Ar [E]Autoscalz

Use these buttons to step through timestamps, and
jump to specific locations in your data.
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2.6.6.2 Jumping between data runs

Automatic markers flag the start and end of each data run.

[ [190 demo daily release build_20191008b_r2019-10-04-86258.dbdoc] Live Data Watch Wil Low
up Block View Options Hel

10-8-201% 10-8-2013
16:34:0( 16:35:00

|:"EI'|ZE F' un harder
Timestamp ¢ . _ ta Run Marker . Sl .-"'- m ﬂ ﬂ ﬂ
ey 1010 BB Ronrsven™ 14l 41 B Navigation

Use these buttons to jump from data run to data run,
skipping over times when no data was collected.
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2.6.6.3 Using the navigation plot

The navigation plot shows a birds-eye view of all the
data that has been collected.

190 demeo daily release build_20191008b_r2019-10-04-86258.dbdoc] Live Data Watch Window L i:h

File Group Block View Options Help

10-8-2019 1)-8-2018 10-8-201¢ 10-8-2019 123
16:32:00 15:33: 16:34:00 16:35:00 16:

[
+

124.875

123
i 23
Ty
i

[Tl =4
1,20,02 B 3614

Autopause at 5:29 AM 10/9

10-8-2019 10-8-2019 10-8-20 3
16:30:00 16:32:00 16:34:00

St TR )

Drag the red frame to change the
view in the detailed plot area above.



2.6.7 Managing Watch Window
related bandwidth and disk usage

The Live Data Status Bar helps you to monitor
how your system is being used

[Send/s:3.00 Recv/s:3.39] Data Files [294KB] &l

Outgoing data Incoming Total of all
requests per responses watch window
second per second data on disk
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2.6.7.1 Managing bandwidth

» CIU is limited to about 20 data fetches per
second.

> Multiple Hyperviews share this bandwidth.

> Be aware of your bandwidth use.

Watch Send/s and Recv/s.

[Send/s=:3.00 Recv/s:2.39] Data Files [405KE]

If Send/s > Recv/s, reduce data load.
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2.6.7.1 Managing bandwidth (cont'd)
How to reduce data load:

» Pause data collection for a group or D Collecting
block by clicking on clock icon. R

> Reduce requests from main browser
window by turning off live data, or Snapshot
switching to Snapshot mode.

> Make sure the Watch Window blocks [, 4ums .
. WL EFT 03

are not updating more often than #1020

needed. Increase the update interval ¢ A

for groups or blocks.



2.6.7.2 Managing disk usage

Send/s:3.00 Recv/=:3.39] Data Files [294KE] ﬂ

» Monitor Data Files

> Avoid collecting data unnecessarily — remember,
the Watch Window is collecting data even when it
IS not open.

> If necessary, move or delete data files directly.
The Managing Live Data Load section later in this
presentation will explain how to do this.
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2.6.8 Selecting and exporting data

Press Select Mode, You can export the
then drag the mouse selected data, and import
to select data. it into a spreadsheet.

10-1-2013
16:20:00

‘Watch Window Data

Data Export Summary

Specify an export
timeslot size.

Choose export mode: {+ Exportinto imeslots { Export All Data
: Data is saved in a

Choo nma (" Tab (T5V)

ill be exported into 10.00 s
rride this def:

CSV file, one

Data Export Timeslot

™ Suppress export of timeslots with no data.

datapoint per
el {imes|ot.

y this format:  m/dfyyyy h:mm:ss.000
(Scatter) to plot data.

export of bad quality and error status data (recommended)




2.7 The Error Browser

Click on an error to

Show these errors

I Hyperview browser

Group by then by

PCU - ||Module <

Sort by

Include starsichecks from

t registersd for data

: Used in display [111]: Module 1,01,
not used on any grap
not used on any graphi
Station span * PID gain less than 80.0 [17

Error: Station span * Pl' gain less than 80.0 [178] ( 4) Melpl

Station Module 1,01,07 Block 4271 span 24.0 [510] and PID Module 1,01,02 Bleock 4236 gain
1.33 [53] product 79, ! is less than 80.0 [L(

Error Description

an be tuned, butthe tuning con

will not be izi "andthu
This m ge repg stem information thatis othen difficult orimp le to find.

Complete error d  umentati

All errors
shown In tree



2.7.1 Error Browser Overview

vV V V VYV VY

Y

Errors are built into the project

Errors displayed in special browser in Hyperview
Group, filter, sort errors in useful ways

Mark errors for special attention (add star)

Review errors (add check) and indicate they have
been seen

Share error stars and checks with other users

Hide errors that don’'t need attention



2.7.2 Opening the Error Browser

To open the Error Browser:

File

[i90 demeo daily release build_20190912a_r2019-09-10-86149.dbdoc] Error Browser

Show these errors

—

I o in di 1]: Module

> Press the e
~ || Module 4 0 in di 1
: Used in display [111]: 1,0
I tt t I ordinates out of order [

: Used in display [111]: M 0

registered for dats 4 not used on any grapl or
ource: [111]: Module 1,0

not used on any grapl or :

Sort by

Include starsichecks from

> I reSS E Error: Station span * PID gain less than 80.0 [178] (295 of 564) [Help]

Station Module 1,01,02 Block 4271 span 24.0 [510] and PID Module 1,01,02 Block 4256 gain
3.33 [S5] product 79.92 is less than 80.0 [L1010240X.CAD]

Error Description

> Select View | Error S
Browser

cantrol njcurithm.

Complete error documentation...




2.7.3 Marking Errors

To manage errors, mark them. Then show only
those errors you have marked.

>* Indicates that an error requires attention
> @ Indicates that an error has been reviewed

> Q* Indicates that an error can be hidden
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2.7.4 Filtering Errors

To manage errors, mark

them. Then show only those (

errors you have marked.

Show only
Hidden errors

Show only

Active (not
hidden) errors v —

Show all errors

show thesuwerrors

Hidden |

Group by then by : :::-:--; ::-_._ :-: avatem confi

E-Active Errors (1130 shown)
-[ERROR] Probable systemn configuration
-[BUILD] Build setup error: Contact GMCL
-[CHECK] Possible system configuration &

-[INFO] System information message: For
: -[INTERMAL] DBDOC program problem: Re

snuwethese errors

=-All Errors (1132 shown)
gl --[EF'.F-'.DF'.] Probable system configuration &
Sammi== | Hone j --[E|I_IILIZ:-] Build setup error: Contact GMCL b

: -[CHECK] Possible system configuration er

wiroup by then by

Sort by

Error Name -

Include starsichecks from

- ] System information message: Fori
(- [INTERNAL] DBDOC program problem: Rep
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2.7.5 Grouping Errors

To manage errors, mark them. Then show only
those errors you have marked.

Errors grouped by
their severity, and
then by error name

Errors grouped by
which subsystem they
are associated with

Show these errors
All
[=-AllErrors (1132 shown)
E| [EF'F'DF‘] Probable system configuration error: Evaluate -
[ old algorithm and inhibit inputs [087] (2 shown)
["1Madule 1,01,02 Block 1544
& [2] Module 1,01,02 Bloc 4
red tag has no source - module not built [285] (
licate tag in database [103] (1 shown)
@ [N B1REMCONT

‘ Group by then by

E-;-&'.-'&r'rt:-.-' - W

Sort b!l"

Show these errors

Al
=-All Errors (1098 shown)
- Configuration (217 shown}
H Eraphus (870 shown)
(10 shown}
E-uplin atPta; in database [1I'Iu] B1REMCON

‘ Group by then by

Sort by

||:|||.1rr-4aame e

Include stars/checks from

"r'EZ'I_I (Mot registered for data s

jijTa; rPnamPst:
[4]Unknown tag typ



2.7.6 Sharing Errors

You can share error stars and checks with other
users. Share the task of reviewing errors.

Include error | W

i nfo rm ati O n fro m [ P [E-Starred Errors (5 shown)

|é|--[EF'.F'.UF'.] Probable system configuration error: Evaluate - high

Severty * IWI |é|--F[;):j:- uses large values and may not clamp output [034] (S
other users %o -

ot 1] Module 1,01,02 Block 13359
Sort by

include stars/checks from

4] Module 1,01 ,02

ot [E] Module 1,20,02
[ you: deciyn en cTHULHU

E| John Smith {IEUser on IE10W
.J:anE Jones {|IEUser on IE11W

SN———

View and filter based
on stars and checks
added by other users
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2.8 Customizing the display

>

Many options for showing & hiding information
View & hide specs, attributes, tag names
Highlight search hits and hotspots

Show thumbnails in graphical indexes



2.8.1.1 Specs on CAD and CLDs

la0.0
100 .0
1.0

> Press S to show and
hide specs

512 64.0
513 106.0

» The gray spec boxes cad b =Xl
can be moved around Sl

S -
S8 5 i?é29001E+18

59 0.0 : ']
- 0.0
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2.8.1.1.1 Live Specs on CAD and
CLDs

CH G

» You can enable live specs
by choosing Enable Live
Specs from the View Menu

» Turn on live specs by
clicking the camera under
layered (gray) specs.

> Fetch live specs by clicking |G
the camera icon again.
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2.8.1.2 Attributes on
CAD and CLDs

Toggle attributes on configuration diagrams by

pressing A. \

Tag: 29-L1-107 rag: 29-LI-107
HRSG1 MVIB HP HRSG1 MVIB HP
L EVEL LEVEL

[FC3a]
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2.8.2.1 Highlighting search hits

Use Highlight | Search Hits to make it easy to see

search results in the browser.

6258.dbdoc] Module 1,01,02: 1010203A.CAD

]

I\‘h;u:lule
Module

1,01,0
1,01,0

Conductor

SODGSYM N Svmbols

n

Help

Group

FTAT115
HP YAPOR H
P E

FTAT121
HP WAPOR TURBINE
INLET P URE

FTAT181

H IF

ata Files [51M] | ufy
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2.8.2.2 Highlighting hotspots

Use Highlight | Hotspots to highlight all the
hyperlinks on a page

Table of Contents Pl =1 1 -1 .01 §—l=] F
BLOWER No.1 C ONT ROL

Databases

ag Index (All Databases)
Tag Database
Trend Database
XDC Configuration

System Information

LUBE OIL PUMF

Conductor NT Grapl
Graphics
Graphics

Conductor NT M1 Si

Lonductor NT M2 Si
1bols
ymbols

STARTUP IN PROGR.E::
SHUTDOWN AL A
NORMAL / TES

COOLANT FLOW

Configuration

—
[l




2.8.2.3 Showing “Vegas Lights”

Vegas Lights are a colorful marquee that highlight

selected hotspots. Enable them with Highlight |
Vegas Lights.
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2.8.3.1 View options
These settings are in Options |
View. Some useful options: Vo | e LosSeup | Cotr | e et | S|

General Settings

[ Larg toolbar Default Date Format | - On Startup

> Default Date Format = MMDD = ey T

¥ Show thumbnail images page
I ) I ’ I \’ I I\’ I Magnify text on tent ’— y | Enable GDI+ drawing Log meta debug
O r documents by: Lol o tto fix misgsing lines) - commands

Hotspot Enabling

Properties for Hyperview

0 . [ Enable function block hotspots ¥ Enable function code hotspots
» Show thumbnail image —

Live data fort: |Aral Mamow i

toggles display of thumbnails  |EG_—_———
for graphical documents

Text size: L2

arch Settings

» Update interval — defines how S —

often live data on documents
IS updated

[~ Reset to show all suppressed dialogs

Cancel
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2.8.3.2 Color options

Use Options | Color
Scheme to set the colors of
various Hyperview features
such as annotations and
search hits.

All colors can easily be set
back to the default.

Properties for Hyperview

View | Live Loop Setup  Colors | Print Settings | Sharing |

General

DR AN

Search hits highlight=:

Digital data "OFF":

Bad quality data:

Restore all default colors
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2.9 Text annotations:

Making notes on documents

Annotations are like electronic
sticky notes. There are two types:

» Text annotations (just text)

» Live loop annotations (live
block, spec, or module
status data)

1@l

Thiz iz &
sample text
annotation.

=G

(® /101,02 B 6824

M

23.21875 HTAS@75

VAPOR TRIM
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2.9.1 Text annotations

Annotations can be used as reminders, notes to
colleagues, or as a way to communicate with
consultants.

IV ILT

B 5YPASS
'r- VALVE

To create a text annotation:

> Click on in the toolbar

» Right-click on the document and choose Text
Annotation | Create
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2.9.2 Managing annotations

In the Annotation Manager, you can see all the
text annotations in your project at once.

To open the Annotation Manager, click

All the annotations ==y, |
are displayed here. s e 2

Delete

Selected
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2.9.3 Searching annotations

All the annotations in your project can be
searched for particular text strings.

Find in Annotations...
Find what: | pipe
[ Regular Expression
Search in:

" Annotations
{ Live Loop Annotations

(* Al of the above

Tags beginning ... SALES GAS PIPELIME BLOCE
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2.10.1 Printing a single document

You can print any document displayed in the browser.

Dark backgrounds can be Zoom in to print part of a
made white to save ink. document. The zoomed
portion is indicated.

190
daily relea uild,

= ) [Fc33]
(] O, - || Sample - 41..7
Gas Stor age & Conductor NT Graphics Gas Storage & Co bl T
1

gr‘m\iun [
6.0M : g % = —

4.0M

2.0M

0.0M

GAS COMPOVERVIEW |
Siudge Gas Flow 5 [eASTomDER OvERVIE |
(8= WATER RECIRC OVERVIEW

0ot s 5100 18 b

VAPO @ TURBINE MW

0.0 deg €

Sample Conductor NT Graphics: GAS_STORAGE_AND_COMPRESSION_OVERVIEW.m1 (Number 1050)

Print Area




2.10.1.1 Advanced print options

Advanced Print Opticns...

These include the basic i
Options Shown earlier, plus GAS_STORAGE_AND_COMPRESSION_OVERVIEW.m1 (Mumber 1050)

COptions set he n—-.:q:np-.« oy 1t:|ﬁ'| print job. Use the Print Settings tab on the

other possibilities. s
L Caption Ii

[ Print Full Sheet (Suppress title/caption, date, etc.)

> A d d t. t th [+ Ink Friendly Print (Removes background, darkens colors)
a Ca p I O n O e Indude the following on the printout... Title/Caption Font Settings:
[ Annotations Formt:  Arial
pag e o [ Live Loop Annotations Size 18

oize:

[ Error Markers Weight: 400 (FW_REGULAR)
- Italic: Mo

» Choose whether to " Veses g

[ Document Path and Filename Modify Title/Caption Font

include various features
on the printout.




2.10.1.2 Fast Print

If you print frequently, use Fast Print.
» Select File | Fast Print from the File menu

> Press P on the keyboard

The Print dialog choices from the first print will be
applied to subsequent prints



2.10.2 Marking the current topic
for later printing

Using the right-click menu, you can mark a topic for later
printing. This is convenient for printing many topics at once.

> Mark the current topic for printing with Mark for Print |
Mark <topic> for Printing

» Over a block hotspot, mark the block's index for printing
with Mark for Print | Mark <block index> for Printing

» Over a link hotspot, mark the linked topic for printing with
Mark for Print | Mark Linked Topic for Printing
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2.10.3 Using the Mark for Print
dialog to print groups of topics

Later, you can print these marked topics from the File |
Mark Topic for Printing dialog.

i ' Mark Topic for Printing

M a rked tO p i CS a re : or the Marked Topics list.

Current B er Topic:

collected here. =
Some or all of them
can be printed.

*Group: POF Documents
Gr icati

Ladder Diagrams
Management of Change Files
Missing Grap
Miszing Symbo -model Referer
Reports
Table of Contents

. Undefined Tags

¥ Remove all topics from Marked Topics list after printing.

Print All Marked Topics
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2.10.3.1 Marking a group of
topics for printing

To select an entire category of E
topics for printing:

1. Select a group of topics
from the Groups list.

2. Click Add Selected
Topic Group.

The topics will be added to the tree in the Marked Topics
area. Expand and uncheck any topics you do not wish to
print.
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2.11 Tools, reports and indexes

PCU Report Page 1: 1,00 to 3,05

A variety of reports and indexes are |- EE e
built into the the project system
snapshot.

Imported b
Exported Point Module 2,02,20 Bloc!
Imported by Module 2,01,10 Block

In addition, Hyperview provides 0909 remorts from 10 201

Module 2,02,20 Block 5419 gets value from Modul

Module 20 Bloc gets value from Module 2,01,20 Block 1

Module 2,02,10 Eloc gets value from Module 2,01,20 Bloc
2,

tools such as the Audit Window and
Graphics Cross Reference Window.

Live F{x) Graph for 1,1,2 Block 1344

Module 1,01,02: Block Map

Reports
i Source in Configuration
urce used in Graphics
with No Source named in Database
List of Unused Tags

Blocks 3
Blocks

2
3
4
2

B
| e | e e e o | e e
340 34 342 343 344 M5 346 347 48 349

E Iz
-------:-- 350

4 [EE s a7

444 M5 a6 a7

S e e ;i

5
5
S
5
]
5
5
5
5
i
5
5

TEp——




2.11.1 The Audit Window

The Audit Window shows at a glance all the resources used
in a CAD/CLD or graphic.

> Open the Audit Window with View | Audit Window

> Press on the toolbar

Lists the blocks, tags, @

input and output -
references and function [
codes on the graphic. g m e B DuyCycle

Click on any item to
highlight it on the
document.




2.11.1.1 Why use the Audit Window?

> C h eC kl | St fO r ta g S 2] 190 c 020-05-27-87886.dbdoc] Audit Win.. — O

> Check all places a block is
used on the CAD/CLD or
graphic

=t RAS_SCREWPUMP_CONTROL_OVERVIEW.m1 (not in

BHP LEVEL){2

{PUMP 1 H']UF RUN METER) { 1]-
0l

> Verify that a block is used
consistently

> See the tags on an AutoCAD
or MicroStation sheet

» On graphics, determine if the
uses of a tag are spread
across the page



2.11.2 PCU Report

Use the PCU Report to see what blocks are exported and

imported between units. TSI SETIEN]

How to read this report:
The PLUonth Iftl radflrtth n E or "I", then the PCU on the top.
5 = 2 I.

To see the PCU Report,
click on PCUMap.txt in
the Miscellaneous
Indices chapter in the
main table of contents,

then choose one of the
PCU Report links.

| Interactions between PCU 2,02 and PCU 2,01
PCU 2,02 exports to PCU 2,01

Exported Point Module 2,02,20 Block
Imported t\. Module

Click on any entry in the table

to see the exports and imports uosie 02 moc.;i_:agi;a';:::';iz;r";sz:f.fk
between two particular blocks.

Module 2,02,20 Block 9542 gets value from Module 2, 01,10 E‘.Ioclr 47%\



2.11.3 Graphical Block Map

The Graphical Block Map is a visual representation of how
each block in the system is used.

To view the Graphical Block Map:

»Right-click on a

DB [Exporied ) | [Tag ] [Tag no F| [Unused Tag] unused e

graphic or CAD/CLD

and choose Go To

Block Map

»Choose the Block
Map link at the start of
any Module chapter In
the table of contents




2.11.3.1 Graphical Block Map:
color coding

The Graphical Block Map shows how
each block in the system is used.

> Used
> Used in the configuration, but no source (or source not built)
> Used on a graphic, but not sourced in the configuration

> IIm&irenced in a database, but not sourced in the configuration
Has no source, but is sourced somewhere in the system
> Exported, but not tagged (blue bords

> MEL Tagged but not exception reported.
The Perfect Block:

> lagged and exported (black border)
Unused| . tagged, exported, used
> Block is tagged, but not used

> Completely unused J



2.11.4 Tag Index

The Tag Index is an index of all the tags in your databases.

To view the Tag Index, select Tag Index in the Databases
chapter of the table of contents.

Alphabetical The block associated with each tag
index of tags In each database is shown.

Tag Index | Tags beginning with 0

Tagname Tag Description l190demod
I_Tagﬁ I:leginning with .jl OOTGO118 40xV 130 OPEN 1,20,02 B 8404

Tags beginning with 3 00TGOT20 I:I.:iS AMALYSER N I,ED_.D'.E BE 1974
Tags beginning with 4 OLOT1-P41-M03 COAL HANDLING 241-1 1,01,06 EOQ

Tags beginning with 8
Tags beginning with A
Tags beginning with B
Tags beginning with C




2.11.4.1 Using the Tag Index:
absent and Inconsistent tags

Each column lists ABSENT indicates a
the block for the tag  tag is not used Iin
In that database. this database

Tags beginning with 53-3
Tagname Tag Description PrimHarmServ TD_CHEMTG_@Hd TD_KILN_KILN

++ 53-30 5,08,10 B 334 ABSENT ABSENT
53-30 RUN 23-30 RUN TIMER ABSENT ABSENT ABSENT
53-30-RUN 53-90 RUN TIMER 5,08,10 B 943 ABSENT ABSENT
53-31 HWH GESSHEREMAL COND. PUMP NO.1  5,08,10 B 364 ABSENT ABSENT
53-32 GEO DA FEELVRATER PUMP #1 5,08,10 B 354 ABSENT ABSENT
33-32 RUN  53-32 RUN TIMER ABSENT ABSENT ABSENT

Indicates an
To find inconsistent tags, inconsistent tag. The tag is
do a text search for ++  ggsociated with different blocks in
different databases. This could be
a concern.



2.11.5 Graphics Cross-Reference
Window

The Graphics Cross-Reference Window shows all the
graphics that link to and from a given graphic, plus included
symbols.

To show the Graphics Cross-Reference Window:

>Open the Graphics TP T Er IO E YA Y TYECT LI L

5 1 I 0

C.ross-Refe.rence Window [ELIIEEE. RN
with Go | Display Cross
References

Conductor NT

nductor NT
nductor NT M1 Subl
nductor NT M1 Subl

100



2.11.5 Graphics Cross-Reference
Window (cont'd)

Click on any item in the Graphics
Cross-Reference Window to display it
In the browser.

L] L ]
G ra p h I CS th at | I n k ll [i190 demo daily release build_20190812a_r2019-09-10-86149.dbdoc] Sample Conductor NI Sraphics: BLOWER_1_COVERVIEW.m1 (... = =]

File i nark h Hi ght Help

to the one shown JFEEE

Sample =2 .
Conductor NT BLOWER No.l CONTROL

Graphics that the
shown graphic T

. y ductor NT Graph
I I n kS to San ductor NT Graphics
g ductor NT Graph

N_TA

EWPUN
ductor NT Graphics

Symbols includea s
on this graphic

nduc

onductor supp

111 Alpha

101



2.11.5.1 Using cross-references to find

symbols no longer used by
your graphics

» Step through your symbol chapters
> Bring up the cross-references for each symbol

» Symbols that are never used will have a blank
cross-reference page



2.11.5.2 Using cross-references to
locate graphics linked to but
not built

> Step through your graphics chapters
> Bring up the cross-references for each graphic

> Entries followed by (not linked) in the Cross-
Reference Index indicate that DBDOC was unable
to build the graphics called for; either the build was
iIncomplete or some of the graphics are trying to
link to graphics that no longer exist



2.11.6 Function Descriptions and Uses

The Function Code Descriptions and Uses index lists and
links every instance of each function code in your system.

To view it click on
Function Codes in

the table Of Function Code Descriptions and Uses
contents. FCiol  USES () High Select

A C. SES (110} Manual Set Constant (Signal Geng
A-INT C5] SES (40) Manual Set Integer

ADAPT C2¢ SES (45)  Adapt

Al/B C25 S5ES (56)  Analog Input (Periodic Sample)
AlfL C26 SES (3) Analog Input/Loop

AlS (FBS C13: SES (42)  Analog Input/Slave

AND 2 C37 SES AND (2-Input)

AND 4 C38 SES AND (4-Input)

Click on the function name Click on USES to see an

to see a description of its index of all the places that
specs and outputs. function code is used.



2.11.7 Graph of F(x) Function Code 1

INFI 90 Function Code 1 implements user specified
piece-wise linear functions.

> To view the graph right
on the CAD/CLD, right-
click on a FC1 block, and
select Show Function
Graph for Block.

> Press S to view the

specs on which the graph
IS based.

> The live data will update
along with live data on
the underlying CAD/CLD.
Press 2] to update on
demand.




2.11.8 Adapt blocks

>

Click on Function Code 24 in the Function Code Index
to see a list of all the Adapt Blocks in the system.

Right-click Go To Use on an adapt block output tells
you what block it adapts. Double-click to jump there.




2.11.9 Rung block display

Rung blocks are heavily used in some systems, e.q.
ETSI turbine control systems.

> Press S to display the
ladder diagram describing
the rung block function.

> Press to display live
iInput, output, and internal
values right on the ladder
diagram.




2.11.10 AutoCAD and MicroStation

AutoCAD and MicroStation drawings are integrated right
into the DBDOC snapshot.

» Tag names are used to
build these links.

» Live data can be displayed
AutoCAD and MicroStation
drawings.

» The phrase-match algorithm
used for constructing links
can be modified in
BuildPlus. We can also
customize it, to make sure
you get the links you want.




2.12 Managing live loop
data connections

In order to fetch live data to display on documents,

Hyperview needs to know the location of at least one

ClUMon server (the DBDOC live data server).

Live loop connections can be configured

> In BuildPlus, and built into the project snaphot (the usual
and preferred approach)

> In Hyperview, using Options | Live Loop Settings



2.12.1 About live data settings

>

>

Live data can be displayed on documents in Hyperview.

Data is fetched from the CIU via one or more DBDOC
data servers (CIlUMon).

Some systems have one ClUMon server. Some have
multiple CIUMon servers.

Sometime certain CIlUMons are available on one
network (e.g. DCS LAN) and other on another network
(e.g. business LAN).

Usually the settings (i.e. list of data servers) are built
into the project file.

Possible to create “Custom” local settings in Hyperview.



2.12.2 Live Loop Setup dialog

Properties for Hyperview

View  Live Loop Setup | Colors | Print Settings | Home Button | Sharing |
» View and manage R
CO Nnn eCt| O N S to C I U M O N d ata ls;_h.;-ﬁ- demo fake) data
Se rve rS . % Use local settings

» Settings are usually built into
the project file, but can be
configured locally (“‘Custom” [miem——

Local port autobind range

S etti n g S " ) &% Use defautt port range (5100 to 5200) _

(" Use custom port range (5100

Edit routing preferences

Unavailable data:
{none)




2.12.3 Choosing a settings list

» Usually one or more
server lists are built into
the project (project) file.

> Multiple lists are usually
for multiple network
contexts.

> Hyperview can
autoselect the best list.

> You can define a local
custom list of servers.

e Usze a ClUMaon settings list fram the project file

(" how demo [fake] data

-

7 Use local settings

R T

Usually you would use
the built in settings in the
project file.



2.12.4 Understanding your current

live loop settings

You can see whether servers are connected, blocked,
unavailable, and also which data requests are being sent

to each server.

List of CIUMons this The ClUMon on asclepius
Hyperview is connected 10. ot 5099 is connected to a
ClUMan gettings: AhE Leimed

oogbn [Por [smw  F [ locaivot| Usedtm

asclepius A093  Connected to loop 3 5100 B.197.1

\ \

The CIUMon on locahost Each connection to a
is blocking this user. ClUMon uses a local

port.

Add | | | |

Data requests for these
loops are being routed to
this ClUMon.



2.12.5 Adding or modifying live loop
connections

Usually settings should be configured in BuildPlus, and
built into the shared project file.

However, in some situations, you might need to change
your personal live loop settings using Hyperview:

> No settings are built into the project file.

> You need to override the settings built into the project
file.

> You want to use a specific CIUMon connected to a
particular CIU or Serial Port Module.

> The built-in CIlUMons settings are not accessible in your
network context.



2.12.5.1 Adding a connection

asclepiug 5093 Connected to boop 3

> Press “Add”.

> Specify the computer i || ea | _oese | igwe |
name and port for the
ClUMon server you want ppmms
to connect to. ClUMon focation

Hostname or IP: |'|IZIS1J’|E|F|‘|E|

Port: | 5099

Connection options

| Force Hyperview to use a spedific local port

Local port: |

Cancel |




2.12.6 Specifying a nhon-default
local port range

» Usually Hyperview automatically chooses ports in the
default port range.

» On occasion, to get through a firewall, you might
specify a particular set of ports for Hyperview to use
when talking to CIUMon.

Local port autobind range

(« lze default port range [5100 ko 5200)

" Usge custom port range 51 oo




2.12.7 Adding routing preferences

> Hyperview automatically — REESSEEE _
I'O UteS d ata req U eStS tO a n Ta ﬁ;n:E requ-r:sts for a |:|ar1j|:ular_ _I_.:.np and PCL to t_::e directed to a
E . particular preferred server, spedfy the Loop and PCU here.
appropriate ClUMon (if

. oop |
there is more than one). o |
PCU | v All
> I N un Usual Cl 'cu mSta Nnces NOTE: If a PCU is spedfied ("All" is unchecked), and the

preferred server is CIUMan 10.3. 1 or older, this CIUMon must

you can force data be configured as an SPM02.

requests for a particular Cancel
Loop (and PCU) to go to a
specified CIUMon server
by creating a routing
preference.




2.12.8 Unavailable data

> LOOpS and PCUs for Unavailable data:

[none]

which Hyperview can't
get data are displayed.

> If live data is turned on
In the browser, but there
are no connected
ClUMons, you will see
items here.



2.12.9 Status of live data connections

The connection icon in the Project
browser's status bar shows the the g Settings
current connection status:

Custom
=—a Settings

[Send/=:3.00 Recv/s:3.39] Data Files [294KE] ﬂ

Mouse over the connection icon to see the status of each
specified connection summarized in a tooltip.

Watch out for these icons. They
Indicate a communication or
connection configuration problem.
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2.12.9 Status of live data connections

(cont'd)
You may see any of these icons in the toolbar. Where

multiple connections have different statuses, the “best”
status is shown.

> — Using built-in settings
» & Connection OK — Using local custom settings

> E Unable to connect — None of the specified
connections have been made, or requested data is
not accessible

B
5

> — This user or IP is not allowed to
mtalk to a ClUMon needed for requested data

have been specified at all

> — Fake data is being displayed
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2.12.10 Compression of Hyperview
data requests

Both Hyperview and ClUMon try to compress multiple
requests for the same data.

>If multiple requests are made for the same data in the
same update interval, Hyperview combines them.

>If multiple Hyperviews request the same data from
ClUMon in the same interval, ClUMon combines the
requests before passing them on to the CIU.



2.13 Managing live data load

On most systems, live data fetch rate is very limited. 10-20
values per second per ClU is typical. Multiple Hyperviews
may share this bandwidth among themselves and with your
other applications.

General strategies to cope:

» Use Rovisys OPC90 Server to get 50-100 values per
second! Contact GMCL for more information.

> Be aware of the live data load you are creating!
> Know how to minimize your own live data load.
» Use more CIUMon servers if you have multiple ClUs.

» Make use of any serial port modules you may have
available.
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2.13.1.1 Constraints on live data
fetch rate

Fast facts:

A single CIU can give up to 20 values/s
Multiple ClIUs can give up to 20 values/s each

Serial port modules can give 80 values/s

vV V V V

Rovisys OPC90 Server gives 50-100 values/s

To increase bandwidth:

> Multiplex CIlUMon servers to your EWS ClUs using
OPC90 Servers.

» Use multiple CIlUMon servers



2.13.1.2 Constraints on live data
fetch rate (cont’d)

Single CIU

> Will probably be on Ring 1 (unless not possible,
or main system not Loop 1)

> Limited to 20 values / second

» Non Loop-1 data will be fetched via Loop 1 — be
aware of increased Loop 1 load



2.13.1.3 Constraints on live data
fetch rate (cont’d)

Multiple ClUs

> You have more than one EWS, connected to
ClUs on different loops. ClUMon can share the
CIU connection with the EWS

»  Multiplex ClUMon and EWS using RoviSys
OPC90 Server Lite Plus. DOUBLE or TRIPLE
data rate with new 2010 OPC90 Server .

> 10-20% cost of CIU makes its spare bandwidth
available for DBDOC

» Get up to 20 more values/s in Hyperview for
each connected CIU



2.13.1.4 Constraints on live data
fetch rate (cont’d)

Serial Port Modules

» SPMs very useful when used with DBDOC
» Each can give up to 80 values / second

» System directly gains throughput, since data
fetched via an SPM does not load the CIU



2.13.2 Managing live data load

for the Watch Window

Tips for managing live data load due to blocks you are

>

plotting in the Watch Window.

Watch the Send and Recv numbers in the status bar.
They show requests and responses per second from
both the Watch Window and live data on documents.

[Send/s:3.00 Recv/s:3.39] Data Files [294KE] !}

Increasgathe Update Interval in Options | View.

Pause data collection for blocks or groups of blocks
you are not actively trending.

Increase the block update interval where possible.

Be aware that Watch Window blocks collect data even
when the Watch Window is not open. 127



2.13.3 How to tell how much
data is being requested

>

Watch the Send and Recv numbers in the status bar.
They show requests and responses per second from
both the Watch Window and live data on documents.

[Send/=:3.00 Recv/=:3.39] Data Files [294KE] ﬂ

If Recv < Send, CIUMon can't keep up. Reduce data
load.

Remember that all the Hyperviews sharing a CIUMon-
CIU connection share the available bandwidth.

View ClUMon statistics for a global picture of how
multiple Hyperviews are loading a ClUMon. Use
ClUMon Options or turn on ClUMonController statistics.
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2.14 Using Hyperview from a
web browser

>

DBDOC supports using a subset of Hyperview

functionality from a standard web browser

This is an ideal setup for tablets and other non-Windows

devices

@ Der
<« G @ localhos

[Dema.dbdoc] Tag: 00TGOT18 (40XV130 OPEN)

=aREEH =

Demo

Table of Contents

Databases

Tag Index (All Databa
20demod Tag Databas
DEMOT Trend Database
C olel XDC Configuration Infal

System Information

Function Codes
Function C s by Number
Undefined T
ng Graphic
ment of Ch

PCU Interactions (Block Imports & Exports

Graphics
Conductor NT Graphics
Faceplates Graphics
Operators Graphics
d r Conductor NT M1
FP support Conductor NT M2 SubM

cAnccvm mhnic

09 Feb 2:15PM 11.5 Alpha r959

2]
he

TAGNAME 00TGO118
TAGDESC 40XV130 O
LPMB

TAGINDEX
CUSTTAGID
TAGTYPE DIGITAL
EUINDEX
VALO

SPAN
SETPTVALO
NUMDECPL
ZEROSTATE
ONESTATE
LOOP

PCU
MODULE
BLOCK
ALMSTATE
H2ALARM
H3ALARM
L2ALARM

Connections Specified]

= f # 0O 2

Signed in as admi

129



2.14.1 Running the Hyperview
Service Controller

» The Hyperview Service Controller will manage Hyperview
services.

> It will need to be run as administrator for full functionality.
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2.14.2 Creating a Hyperview
service

> Click Add Service... to set up the new service.

> Most of the information will be filled in and should work
by default. The main thing required is the path to
a .dbdoc file.

Add a Hyperview Service

Service Name:

DBDOC File to Serve:
:\dbdoc_files\Demo*.dbdoc v Browse... |

[v Use Most Recent

Hyperview Executable:

C:\Program Files (x86)\GMCL\DBDOC \Programs\hyperview.exe Browse... |
Run Hyperview Server on Port: | 8000
Service Startup Type: Automah‘c - Modify Logging & Live Data Options.... |

oK Cancel |
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2.14.3 Running a Hyperview
service

> Once the service is created, select it and click Start
Service to start up the web server.

> The link is displayed in the Website entry but you can
also click Launch Website to open the link in your default
browser.

DBDOC Login

Username |

Password |
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2.14.3 Running a Hyperview
service (cont’d)

> The Hyperview service will be available to anyone on the
same local network as the host.

> The address should be “<hostname>:<port>" where

hostname is the name of the host machine on the
network.

» The port can be changed in the service settings.



2.14.4 Browser Hyperview
accounts

> Access to the Hyperview service is restricted through

user accounts.

By default there is a single admin account that can create
and manage further accounts.

Contact GMCL for the default admin password.

m Add User Account
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2.14.5.1 Browser Hyperview
functionality - navigation

>

Navigation can be done much like in regular Hyperview,
using links and hotspots.

The browser’s forward and back history will work here

too.

[Demo.dbdoc] Sample Conductor NT Graphics: AERATION_TANKS_STAGE_|_OVERVIEW_newname._m1 (not in xdcdump)

Block Use Index

| Module 1,20,02 Block 3274 [AIC3001,
40TIC614-1-CO-R]

1 190demod [Tag Database]

2 12002L1C.CAD
ce (M/A MFC/P: Control Station [FC
Name

APID: Advancec
3 1200299C.CAD

3.1 Input sl to blo UM(K): Summer

09 Feb 2024 2:55 PM | DEV w95542

STATUS

FEEDBACK

JRUNNING

0.0 %IGV

[RUNNING

0.0 % IGY

{RUNNING

0.0 % IGY

UTO STARTUP IN PROGRESS

CIUMON Comms: Custom Settings [No Connections Specified]

CONTROLLING PROBES % DO

2 3 4
0 0 0
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2.14.5.1 Browser Hyperview
functionality-navigation (cont’d)

> Many of the navigation tools found in regular Hyperview
are in the toolbar

Go to Home
Go to Table of Contents
Synch Table of Contents

Next/Previous topic

Next/Previous index entry L L
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2.14.5.2 Browser Hyperview
functionality — text search

> You can search the entire project file for a phrase.

> Open the main menu, expand the Search menu, and
click Full Text Search.

= ! = == B " = 0 = =5 %8 -4

Full Text Search search Results

Search phrase or terms

e | _
D e pump Searched for topics with the following text:

m - [ pump (match exact phrase)
ol Vild one character) o L ~ )
Tﬂ k D G (a2 G ) 862 hits found in 539 topics
1O o Topic Jitle Grou|
Full Text Search ®
- c 9|
D at C cd 1 0203a.b90 (JUICER #2 ..
Tag In
190de
190DE
Conso

Search All Titles
Clear Search Results
* Display Settings

jye N
Results display
»p, PCU, Madule, Block columns
hits per topic

Show topic group

09 Feb 2024 3:06 PM_ DEVw95542  CIUMON Comms: Custom|
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2.14.5.3 Browser Hyperview
functionality — title search

> You can also search for a specific document by its title.

> |n the Search menu, click Search All Titles.

e Demo.dbdoc - DEDOC

= C A Notsecure | emmental:8000/hyperviey

L1
L 1 I
Search All Titles

ype a word:

ras

Document titles:

+

¥.m1 {not in xdcdump) [Conduct...

[Demo dbdoc] Sample C

=14 e
Search Al Titles (o ]

ype a word:

ras |

Document titles: GAS_STORAGE_AND_COMPRESSION_OVERVIEW,
= number 1050

- | B I A=
Stage T Ras Screw Pump Overview
Puip ) e R

——————————————— b— o - {

09 Feb 2024 3:50 PM = DEVw93542  CIUMON Comms: Custom Se



2.14.5.4 Browser Hyperview
functionality — live data

> Live data settings need to be built into the .dbdoc file in
BuildPlus to appear in Browser Hyperview.

» The Hyperview service will fetch and display the live data
In the browser just like in regular Hyperview.

GAS TB KWHR

BREAKER

MW
MVAR OPEN
KVOLTS

GENERATOR
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2.14.5.5 Browser Hyperview
functionality — bookmarks

> Bookmarks can also be defined using the main menu.

> A bookmark URL can be copied from the browser’s
navigation tab and shared between browsers and
machines on the same network just like any other URL.

[Demo.dbdoc] Documentation Text Documentation: LOG40.txt Signed in as admin

LOG40.txt

Bookmark current browser contents:

Text Documentation LOG40 Text File

Name

Documentation | LOG40.txt LOC40.txt
——— liogarax

- log41a.txt M
Documentation Text Documentation: LOG40.txt paY/ TIHE MWHR HUHR
0.
0.
0.
N
0.
N
0.
.
0.
0.
0.
0.
N
0.
N
0.
N
0.
.

Add Bookmark

It
]

]

[

E:
e
P
05
0
0
0
T
:
I
:
E:
]

]

05
0
0
0
[]

:

TAG
TREND#

Show in Tab

09 Feb 2024 3:38 PM  DEVw93542  CIUMON Comms: Custom Settings [No Connections Specified]




For more information on the Hyperview Browser

See the online documentation at gmcl.com, or the
built in application help.

G. Michaels Consulting Ltd
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